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1 GETTING STARTED
1.1 Files included

The program will run on any IBM PC (or true compatible) with Microsoft Windows installed (version 3.11 or higher).  Although a maths-coprocessor is not required, it is highly recommended for the more computationally intensive options within FAOMET.

1.2 Starting the Program

To start the FAOMET program, you must first be running Microsoft windows.  Then, either double-click on the FAOMET.exe icon in the file manager/windows explorer, or click on the FAOMET button on the FAOCAST title screen.

2 BASIC CONCEPTS
2.1  The Menu System

After starting the program, two windows will appear.  The first, and most important, is the

FAOMET menu window.  This consists of a menu bar along the top, from which all the programs’ options are activated.  To select an option from a menu, first click on the menu heading (eg. File).  The File menu will now appear, and any of it’s options can be selected, again by clicking with the mouse.  Note that many menu headings and options contain one character which has been underlined, and these can also be selected by holding down the Alt key and pressing the key corresponding to the underlined character (eg. Alt-F will activate the File menu).  Underneath the menus is the message bar, which occasionally displays text to help the user in running the program.

There are several menus, including data management (File), the statistical agrometeorological options (Stagmet), the standard agrometeorological options (Agromet), and a Help menu for displaying information on several areas of the program.

The second window displayed is the file information window.  This gives information about the data currently loaded, such as the names of the variables, number of lines, etc.  It’s main purpose is to allow the user to check that the data they have loaded is what they intended.

2.2  The Log File

Most of the programs options produce output (messages, results tables, data, etc.) which is all written to a log file.  The default name for this file is logfile.txt, although you can change both the name of the current log file being used (see section 3.4 [Changing the log file]) and also the default name for the log file (see section 6.1 [The Preferences file]).

The log file is cleared  and re-opened each time FAOMET is run.  Therefore, if you have important data currently in the log file, you should either make a copy of the file, or print it out, before running FAOMET again, otherwise it will be lost.

2.3 Defaults and Preferences


There are several default values used by the program, such as the value for missing data, the text editor to be used, etc.  These are all explained in section 6.1 [The Preferences file].

3 DATA MANAGEMENT (FILE menu)
3.1  Opening an Input File

This option is used to read input data into the program, and must be invoked before any STAGMET or AGROMET function can be performed.

To read in your data file, click on the File menu, then on Open input file.  A file selector window will open, allowing you to choose your input file.  (The file selector will always start searching in the directory which has been specified as your data directory.  To change the default value for this, see section 6.1 [The Preferences file]).

3.2  Viewing the Input File

This option allows you to view your input file with a text editor (or any other text viewer of your choice).  

Click on View input file from the File menu.  The text editor will start up, with the chosen input file displayed in it.  The editor will run as normal, independently of FAOMET.  However, note that any changes made to the data are NOT being made to the data loaded into FAOMET, as the editor is only displaying a copy of the data, not the data itself.  If you want to make changes to the data loaded into FAOMET, you would have to save the file loaded into your editor, and then load it into FAOMET again, using the Open input file menu option.

The text editor should be shut down in the normal way after you have finished using it.  Invoking View input file again, whilst the editor is still open, will simply open multiple copies of your editor program.

The editor program used by this option can be changed to one of your choice.  See section 6.1 [The Preferences file].

3.3  Viewing the Log File

This option allows you to view the current state of the log file.

Click on View log file from the File menu.  The currently selected text editor will start up, displaying the log file.  Note that this text editor is running independently of FAOMET.  If you leave the editor open whilst continuing to use FAOMET, the editor window will not show any further additions to the log file; it will only show the state of the log file when you activated the option. 

The editor program used by this option can be changed to one of your choice.  See section 6.1 [The Preferences file].

3.4  Changing the Log File

This option allows you to change the name of the log file currently being used.  This can be useful if you are working on several data files during one session, and want to keep the logs for each one separate.   

Click on Change log file from the File menu.  A file selector window will appear, allowing you to choose a new file to be the log file.  Note that this option only changes the log file for the current session.  When FAOMET is run again, it will go back to using the default log file.  To change the default log file, see section 6.1 [The Preferences file]).

3.5  Writing Input to the Log File

This option allows you to insert your original input data file into the log file, for situations where you want to look at results and raw data at the same time. 

Click on Write input to log file from the File menu.

3.6  Exiting the Program

To exit FAOMET, click on Exit from the File menu.

4 STAGMET OPTIONS
[image: image2.png]




This chapter describes, in detail, the statistical options available in FAOMET and illustrates the theoretical concepts with practical examples.  You are encouraged to work through the step-by-step procedure using the sample files provided on the diskette to acquire hands-on experience with the input file formats and the information contained in the output.


Only a portion of the sample files are listed in the text and the output files have often been edited to contain only the relevant information.  Use the editor provided with FAOMET or your own to view these files in their entirety.

4.1 Computing a Correlation Matrix

This option allows you to describe your dataset with some simple statistics.  Suppose that you are interested in modelling the yield of sorghum in Mali.  You have yield data at the station level as well as several other geographical, agrometeorological and remote sensing variables.  This option will calculate, for all variables in the data file: 


• the average, which is the value to which your distribution converges and is the sum of all the values of a variable divided by the total number of observations;


• the standard deviation, which is a measure of dispersion or variability and is the square root of the sum of the deviations of each observation from the mean squared divided by the total number of observations;


• the coefficient of variation, which is a relative measure of variation and a useful statistic in evaluating results from different experiments.  The standard deviation is expressed as a fraction, or sometimes as a percentage, of the mean.  Since it is the ratio of two averages, it is independent of the unit of measurement; and,


• a matrix of correlation coefficients showing the association of all the variables in the file. 

The coefficient of correlation is the measure of degree of closeness of the linear relationship between two variables, and ranges from -1 to 1.  

For more information on these statistical terms, you are referred to one of several good statistics books [1,2,3].


To illustrate how this option works, use the sample file, SC-MALI.DAT, shown in fig.4a, containing sorghum yield data and several other variables for Mali: NDVI26, which is the value of the Normalized Difference Vegetation Index during the 26th dekad (see [ ] for more information on this variable); IND, which is the Water Requirement Satisfaction Index, a variable computed by FAOINDEX [ ]; LON and LAT, which are the geographic coordinates; LGS, which is the Length of the Growing Season (see section 5.4); NormRain, which is the normal annual rainfall at each station, and PTB28, the..................................................................

PRIVATE 
"Mali 1990, Sorghum yield (LGS and normal rain are L10/1.2/3)"

" ","NDVI26","IND","YLD","LON","LAT","LGS","NormRain","PTB28"

"Bafoulabe",187,92.6,843,‑10,14,115,1027,126

"Banamba",165,92.3,602,‑7.3,13.7,121,914,119

"Bandiagara",144,86.1,431,‑3.7,14.5,94,517,96

"Bankass",157,90.7,472,‑3.6,13.5,116,749,103

"Baraoueli",175,95.4,755,‑6.5,13,125,987,128

"Bla",170,97.1,838,‑5.9,12.9,125,814,128

"Bougouni",183,97.6,395,‑7.3,11.2,161,1297,124

"Diema",162,88.7,792,‑9.5,14.5,104,737,116

"Dioila",181,97.1,496,‑6.7,12.4,136,1103,135

"Dire",128,73.6,0,‑3.2,16.3,44,364,40

"Djenne",149,83.8,702,‑4.3,13.9,110,627,106

"Douentza",139,83.2,297,‑2.5,15.1,76,531,66

"Goundam",133,76.5,762,‑3.7,16.5,43,346,10

"Kadiolo",178,97.1,686,‑5.7,10.4,187,1262,134

"Kangaba",202,98.1,632,‑8.5,11.8,154,1248,126

"Kayes",181,95.8,758,‑11,14.5,106,1092,118

"Kenieba",200,98.8,760,‑11.1,13,145,758,1181
Figure 4.1a : SC-MALI.DAT file


After opening the file, select Correlation from the Stagmet menu.  The correlation is calculated, and output written to the log file.  You can view the log file by using the View log file option on the File menu, and you should see the same information as given in fig.4.1b.


The log file lists the variables with their corresponding ranges, the number of missing data points, the minimum and maximum value of each parameter, a table with the statistics for each variable, and the correlation matrix.

PRIVATE 

Title: Mali 1990 Sorghum yield (LGS and normal rain are L10/1.2/3)

                                  List of variables

              Nr   Name           Number missing   Minimum        Maximum

               1   NDVI26               0           128            202 

               2   IND                  0           66.8           98.9 

               3   YLD                  1           0              1040 

               4   LON                  0          ‑11.1          ‑2.5 

               5   LAT                  0           10.4           17 

               6   LGS                  0           30             187 

               7   NormRain             0           244            1317 

               8   PTB28                0           3              135 

       Complete data lines:  39  / Code for missing data: ‑999 

                             VARIABLE STATISTICS

     Nr  (Name)         Average      St. Dev.    CV%       Min        Max

     ---------------------------------------------------------------------------

      1  (NDVI26    ) ¦ 0.1651D+03  0.1881E+02    11.4  0.1280D+03  0.2020D+03

      2  (IND       ) ¦ 0.8947D+02  0.9059E+01    10.1  0.6680D+02  0.9890D+02

      3  (YLD       ) ¦ 0.5794D+03  0.2507E+03    43.3  0.0000D+00  0.1040D+04

      4  (LON       ) ¦ ‑.6289D+01  0.2385E+01    37.9  ‑.1110D+02  ‑.2500D+01

      5  (LAT       ) ¦ 0.1365D+02  0.1573E+01    11.5  0.1040D+02  0.1700D+02

      6  (LGS       ) ¦ 0.1144D+03  0.3412E+02    29.8  0.3000D+02  0.1870D+03

      7  (NormRain  ) ¦ 0.8412D+03  0.2777E+03    33.0  0.2440D+03  0.1317D+04

      8  (PTB28     ) ¦ 0.1050D+03  0.3152E+02    30.0  0.3000D+01  0.1350D+03

                          CORRELATION MATRIX 

              1       2       3       4       5       6

     +--------------------------------------------------+

   1 ¦        *                                         ¦   1 (NDVI26)

   2 ¦   0.7925       *                                 ¦   2 (IND)

   3 ¦   0.5360  0.5474       *                         ¦   3 (YLD)

   4 ¦  ‑0.7570 ‑0.4049 ‑0.4865       *                 ¦   4 (LON)

   5 ¦  ‑0.7298 ‑0.8128 ‑0.3389  0.2092       *         ¦   5 (LAT)

   6 ¦   0.8183  0.8340  0.4162 ‑0.3842 ‑0.9728       * ¦   6 (LGS)

   7 ¦   0.8496  0.8030  0.4061 ‑0.4795 ‑0.9001  0.9217 ¦   7 (NormRain)

   8 ¦   0.8075  0.8054  0.5818 ‑0.5235 ‑0.7900  0.8622 ¦   8 (PTB28)

     +--------------------------------------------------+

              1       2       3       4       5       6

              7       8

     +------------------+

   1 ¦                  ¦   1 (NDVI26)

   2 ¦                  ¦   2 (IND)

   3 ¦                  ¦   3 (YLD)

   4 ¦                  ¦   4 (LON)

   5 ¦                  ¦   5 (LAT)

   6 ¦                  ¦   6 (LGS)

   7 ¦        *         ¦   7 (NormRain)

   8 ¦   0.8234       * ¦   8 (PTB28)

     +------------------+

              7       8
Figure 4.1b : Log file after performing a correlation

4.2 Simple and Multiple Linear Regression

In addition to determining the correlation or association between two variables, we may suspect that a relationship exists between the two.  For example, we may want to model the sorghum yield (YLD) in Mali (from the previous example) as a function of the Water Requirement Satisfaction Index (IND) and express this mathematically by fitting an equation through the data.  Since we assume that the yield changes as a result of changes in the index, the yield is the dependent variable, Y, and the index is the independent variable, X.  The equation for the straight line of best fit would be:


Y = a + bX

where a is the intercept, i.e., the value of the yield when the index is 0 and b is the slope or rate of change in yield with a unit change in the index.  This is an example of simple linear regression and uses a method known as least squares.  The resulting regression line is such that the sum of the squares of the departures of Y from the line will be as small as possible.  This method takes all the observations into account, giving each of them an equal weight in determining the result.


Suppose we find that our simple linear model explains only a portion of the variation in yield and would therefore like to add two other independent variables, NDVI26, X2, and LGS, X3.  This is an example of multiple linear regression and the equation would become:


Y = a + b1X1 + b2X2 + b3X3
where b1 to b3 are the corresponding X coefficients.

To perform the multiple regression, open the same example file SC-MALI.DAT, used in section 4.1, and then select Multiple regression from the Stagmet menu.  A window, similar to the one shown in fig.4.2a, will be displayed.
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                                          Figure 4.2a : Multiple regression window 1


First you must select the dependent variable.  This is done by clicking on the box underneath the DEPENDENT variable text, then clicking on the required variable from the drop down list which appears.  For this example, select the variable YLD (yield).

Now select the independent variable(s).  This is done by clicking on variables in the list box underneath the INDEPENDENT variable text.  You may select more than one independent variable, but you must not select the same variable to be both dependent and independent.  To de-select a previously selected independent variable, simply click on it again.  For this example, select the variables NDVI26, IND and LGS.

Select Compute values of DEPENDENT variable by clicking on the check box, and the program will list (in the log file) a table of "computed" yield values by using the regression equation with the original values of the independent variables.  

To perform the regression, click on the Compute button.  Results will be written to the log file.


If you would like to calculate individual values of yield (YLD) from manually input values of NDVI26, IND and LGS, then click on the Manual calc. button.  The regression window now changes to that shown in fig.4.2b.  
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                                                       Figure 4.2b : Multiple regression window 2

You will be prompted to enter a value, for each of the selected independent variables in turn, in the small text box in the upper right corner.  The calculated value of the dependent variable will then be shown in the large ‘results` text box.  Note that these calculations are only shown on the screen.  In order to have them written to the log file, click on the Write calculated results to log file check box.

Close this option down by click on the Exit button.
PRIVATE 

Title: Mali 1990 Sorghum yield (LGS and normal rain are L10/1.2/3)

                                  List of variables

              Nr   Name           Number missing   Minimum        Maximum

               1   NDVI26               0           128            202 

               2   IND                  0           66.8           98.9 

               3   YLD                  1           0              1040 

               4   LON                  0          ‑11.1          ‑2.5 

               5   LAT                  0           10.4           17 

               6   LGS                  0           30             187 

               7   NormRain             0           244            1317 

               8   PTB28                0           3              135 

                      Dependent variable Y is nr  3 (YLD)

                             VARIABLE STATISTICS

     Nr  (Name)         Average      St. Dev.    CV%       Min        Max

     ---------------------------------------------------------------------------

      3  (YLD       ) ¦ 0.5794D+03  0.2507D+03    43.3  0.0000D+00  0.1040D+04

      1  (NDVI26    ) ¦ 0.1651D+03  0.1881D+02    11.4  0.1280D+03  0.2020D+03

      2  (IND       ) ¦ 0.8947D+02  0.9059D+01    10.1  0.6680D+02  0.9890D+02

      6  (LGS       ) ¦ 0.1144D+03  0.3412D+02    29.8  0.3000D+02  0.1870D+03

                          CORRELATION MATRIX 

              3       1       2       6

     +----------------------------------+

   3 ¦        *                         ¦   3 (YLD)

   1 ¦   0.5360       *                 ¦   1 (NDVI26)

   2 ¦   0.5474  0.7925       *         ¦   2 (IND)

   6 ¦   0.4162  0.8183  0.8340       * ¦   6 (LGS)

     +----------------------------------+

              3       1       2       6

                             REGRESSION STATISTICS

           Number of observations           N                  38

           Residual sum of squares          RSS        0.1536D+07

           Correlation coefficient          r            0.597563

           Coefficient of determination     r²           0.357082

           Snedecor's ratio of variances    F          0.6295E+01

                          COEFFICIENTS OF REGRESSION

 Variable       Coeff. of regression      Std. errors        B/E

                 B(0)=‑1.3073044D+03

(NDVI26)         B(1)= 5.6454878D+00   E(1)=0.3401D+01  B/E(1)=  1.660

(IND)            B(2)= 1.3966770D+01   E(2)=0.7354D+01  B/E(2)=  1.899

(LGS)            B(6)=‑2.5808350D+00   E(6)=0.2072D+01  B/E(6)=  1.246

                      Nr  observed computed  err%      abs. err.

                   ‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑

    Bafoulabe          1    843.00  744.93   ‑12       ‑98.07141

    Banamba            2    602.00  601.05    ‑0        ‑0.94708

    Bandiagara         3    431.00  465.59    +8       +34.58615

    Bankass            4    472.00  546.45   +16       +74.44629

    Baraoueli          5    755.00  690.48    ‑9       ‑64.51862

    Bla                6    838.00  686.00   ‑18      ‑152.00256

    Bougouni           7    395.00  673.46   +70      +278.46216

    Diema              8    792.00  577.71   ‑27      ‑214.28986

    Dioila             9    496.00  719.71   +45      +223.70862

    Dire              10      0.00  329.72  ‑999      +223.70862

    Niafunke          27     has missing data

    Niono             28    429.00  518.06   +21       +89.05963

     etc.

         Average relative error (absolute values) :    26 %

                                    Extreme errors:   ‑47% and   +87%

         Extreme absolute errors:     ‑471.40082 and   +301.64459

2
Figure 4.2c : Log file after performing multiple regression

The results of the regression analysis are listed in the log file (fig.4.2c).  The file contains a list of the variables, the number of missing data values, the minimum and maximum, followed by the various statistics; the same ones as listed in the correlation matrix except that these statistics are only for the dependent variable and independent variables chosen.  After this appears a correlation matrix of the variables chosen, followed by various regression statistics including the number of observations, the correlation coefficient of all three variables, and the:


• Residual sum of squares - the square of the individual deviations of the computed yield from the observed, and then summed.  This value is used in calculating...


• Coefficient of determination - the % of total variation accounted for by the regression.  In this example, only 35.7% of the total variation has been accounted for by these three variables.  The correlation coefficient given in the table is the square root of the coefficient of determination.


• Snedecor's ratio of variance - also known as the "F" statistic, and can be used to test whether the variances are similar or not.  Refer to Snedecor et al., 1963 [ ].

Following this list of statistics are the coefficients of regression for each variable, marked as B(var#); the equation would read as follows:


Y = 1307.30 + 5.65*NDVI26 + 13.97*IND - 2.58*LGS

Beside each coefficient is the standard error associated with each coefficient, E(var#),  and the ratio of B(var#):E(var#), or the "t" statistic, which can be used to test the significance of the individual coefficient.  As a rule of thumb, only those variables with B/E of around 2 or greater should be retained.  In practice, the straightforward multiple regression is run with a set of not too correlated variables, those with low B/E are eliminated and the regression is run again.  

In the last part of the output, a list of the actual or observed values and those computed from the regression equation are given.  Under operational conditions, the average absolute error should be in the range of 10% to 15%, or less.

4.3 Principal Components Analysis (PCA)

Principal components analysis is a powerful tool used to examine the structure of an input matrix containing the variables used in regression model building.  As we are not certain whether the variables are independent of one another or whether they are important in explaining the variance in our yield, we can use principal components analysis to indicate variables with similar behaviours by redistributing the variance of the matrix among a new set of uncorrelated axes (the principal components).  This analysis permits the replacement of the initial, generally correlated, variables by non-correlated ones.  In addition, the analysis of the components often permits the reduction of a certain number of variables; one can, in effect, often cancel the third or sometimes even the second principal component of the three.  The analysis also provides a complementary interpretation of the initial variables.


The correlations between the components and the original variables give some indications as to which variables are important, i.e., which variables are worth retaining in the multiple regression leading to the yield function.


To illustrate how principal component analysis can be used, examine the input file SP-MET.DAT, shown in fig.4.3a.  The file contains annual yield from 1920 to 1930 and three climatological variables; the mean temperature, precipitation and radiation measured during the month of July.  We imagine that the yield is a function of these three parameters but we suspect that the three variables are not entirely independent of one another.

PRIVATE 
"Meteorological and Yield Data Time Series"

" ","TemJul","RnJul","RdJul","Yield"

"Eg-1920",19.6,1,1661,28.8

"Eg-1921",15.2,90.1,968,29.8

"Eg-1922",19.7,56.6,1353,28.8

"Eg-1923",17.0,91.0,1293,31.0

"Eg-1924",18.3,93.7,1153,28.7

"Eg-1925",17.8,106.9,1286,23.5

"Eg-1926",17.8,65.5,1104,24.6

"Eg-1927",18.3,41.8,1574,27.8

"Eg-1928",17.8,57.4,1222,28.8

"Eg-1929",16.8,140.6,902,23.9

"Eg-1930",17.0,74.3,1150,26.5

3
Figure 4.3a : SP-MET.DAT file

Load in this data file, then select PCA from the Stagmet menu.  The PCA window will

appear, as shown in fig.4.3b.
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                                                               Figure 4.3b : PCA window


Select the variables you want to work with, by clicking on them in the list box.  The Clear and All buttons may be useful if you have a long list of variables; they respectively de-select and select all the variables in the box.  For this example, select the variables TemJul, RnJul and RdJul.

Clicking on the Compute button will start the calculations.

The output from the analysis is presented in two ways: as an output file SP_SP-M.DAT, containing the values of the principal components themselves (fig.4.3c):

PRIVATE 
"Principal components matrix"

,"C‑1","C‑2","C‑3"

"Eg",3.0762,‑.5088,‑.0184

"Eg",‑2.2889,‑1.3406,‑.0741

"Eg",1.3628,.717,‑.2729

"Eg",‑.5932,‑.3788,.6833

"Eg",‑.4316,.5911,‑.0799

"Eg",‑.5101,.4145,.7205

"Eg",‑.3304,‑.1875,‑.5809

"Eg",1.5769,‑.5787,.614

"Eg",.1267,‑.4035,‑.2853

"Eg",‑2.5724,.6037,.1075

"Eg",‑.7119,‑.5771,‑.091

4
Figure 4.3c : SP_SP-M.DAT file
and the log file. This information allows you to interpret the results and determine which variables can be used in the regression model (fig.4.3d):

PRIVATE 

Title: Meteorological and Yield Data Time Series

                                  List of variables

              Nr   Name           Number missing   Minimum        Maximum

               1   TemJul               0           15.2           19.7 

               2   RnJul                0           1              140.6 

               3   RdJul                0           902            1661 

               4   Yield                0           23.5           31 

       Complete data lines:  11  / Code for missing data: ‑999 

                        % VARIANCE /COMP.

           Component     %variance     %accum. variance

               1           81.6            81.6

               2           12.8            94.4

               3            5.6           100.0

           Correlations between Components and original variables below

                                  TemJul

                                  RnJul

                                  RdJul



                 1         2         3

             


 TemJul    RnJul     RdJul 

    


  -‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑

    


1 |      0.8671   ‑0.8990    0.9429 |  C‑1       

    


2 |      0.4843    0.3760   ‑0.0868 |  C‑2       

    


3 |     ‑0.1167    0.2246    0.3214 |  C‑3       

      

 
  -‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑

    
            

    1         2         3

5
 Figure 4.3d : Log file after performing PCA

The log file lists the variables, their extreme values and the % of variance explained by each component.  This is followed by the accumulated variance of each component and a correlation matrix.  This information tells us that the first and second principal components together explain 94.4% of the total variance and the third component can therefore be discarded.  Geometrically, this means that all the observed points find themselves on a plane and 94.4% of the variation is parallel to this plane while 5.6% is perpendicular to it.  In addition, 81.6% of the variation corresponds to the principal component and only 18.5% to the other two.  The second and third components can therefore be discarded.


A correlation matrix is also provided in the output file and one can interpret the behaviour of the initial variables.  Since the first principal component is positively correlated with temperature and radiation, and negatively correlated with precipitation, the first principal component is an indicator of alternative good and bad weather.  High values of the component correspond to high temperatures, high levels of solar radiation and low precipitation.  The second component is poorly correlated with radiation but has some correlation with temperature and precipitation and can thus be considered as marking the annual distinction between hot and humid years and relatively annual cold and dry years.


Now try principal component analysis on the file for Mali, SC-MALI.DAT.  What does the analysis tell you about trying to build a yield regression model with these 8 variables?

4.4 Trend Analysis

Trend refers to the overall behaviour, or tendency, of one variable with respect to another, generally expressed as an upward or downward trend; a situation of no trend or multiple trends is also possible.  For example, during the past 100 years, yield has increased with time, i.e., an upward trend, due to increased technological inputs.  The rate of the trend is the slope of a line of best fit and can be calculated by regressing one variable against another.    


Two different types of trend changes are shown in fig.4.4a.  In the first curve, the slope (or rate of change) remains the same but the curve is shifted up or down due to a change in the Y-intercept; in the second curve, the slope changes and the two curves intersect at the point where the trend changes.  In the case of yield increases over time, the changes may be due to the adoption of new technologies (fertilizer, mechanization, irrigation) or new varieties.  With this function you can calculate when a trend change occurs and the types of trend changes that are present in the data.
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Figure 4.4a : Types of trend changes

Examine the sample file ST-CHINA.DAT, shown partially in fig.4.4b.  The file contains yield, area and production time series data for potatoes in China from 1961 to 1990, taken from the AGROSTAT database [ ].  Let's use this data to determine if there is a trend change in yield over time.

PRIVATE 
"AGROSTAT/PC China Potatoes ('000 Ha, '000MT, MT/Ha)",,,

"Year","Area‑Harvested","Production","Yield"

1961,1301,12907,9.92

1962,1501,13808,9.2

1963,1501,12010,8

1964,1602,14019,8.75

1965,1701,16016,9.42

1966,2001,18016,9

1967,2002,17923,8.95

1968,2002,17822,8.9

1969,1902,19328,10.16

1970,2002,21524,10.75
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Figure 4.4b : ST-CHINA.DAT file

Load this data file into memory, then click on Trends from the Stagmet menu.  The Trend analysis window will appear, as shown in fig.4.4c.  First choose the variable with the suspected trend change (in this example, the Yield) by clicking on the box and selecting Yield from the drop-down list which appears.  Now choose the trend variable in the same way (in this example, choose Year).
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                                                             Figure 4.4c : Trend analysis window

After clicking on the Compute button, the calculations will proceed and the output will be written to the log file.  View the file and you will see the same information as is listed in fig.4.4d.

PRIVATE 
                   Source file: C:\TESTDATA.FAO\ST‑CHINA.DAT

                Title: AGROSTAT/PC China Potatoes ('000 Ha '000MT MT/Ha)

                                  List of variables

              Nr   Name           Number missing   Minimum        Maximum

               1   Year                 0           1961           1990 

               2   Area‑Harvested       0           1301           2852 

               3   Production           0           12010          31663 

               4   Yield                0           8              13.5 

       Complete data lines:  30  / Code for missing data: ‑999 

------------------------Identify trend changes, option ST------------------------

                        Trend in variable  4  (Yield)

                        Trend‑variable  is  1  (Year)

   1‑i         m         p        i‑end       m         p      Itcp.  Delta  m1‑m2

1961‑1962 ‑.716D+00 0.141E+04  1963‑1990 0.689D‑01  ‑.126E+03  1961  0.022  ‑7.852D‑01

1961‑1963 ‑.959D+00 0.189E+04  1964‑1990 0.539D‑01  ‑.957E+02  1961  0.067  ‑1.013D+00

1961‑1964 ‑.471D+00 0.933E+03  1965‑1990 0.414D‑01  ‑.710E+02  O.O.R        ‑5.121D‑01

1961‑1965 ‑.145D+00 0.294E+03  1966‑1990 0.321D‑01  ‑.525E+02  O.O.R        ‑1.773D‑01

1961‑1966 ‑.912D‑01 0.188E+03  1967‑1990 0.153D‑01  ‑.192E+02  O.O.R        ‑1.065D‑01

1961‑1967 ‑.676D‑01 0.142E+03  1968‑1990 ‑.714D‑02  0.252E+02  O.O.R        ‑6.050D‑02

1961‑1968 ‑.562D‑01 0.119E+03  1969‑1990 ‑.368D‑01  0.840E+02  O.O.R        ‑1.941D‑02

1961‑1969 0.367D‑01 ‑.630E+02  1970‑1990 ‑.572D‑01  0.124E+03  O.O.R         9.390D‑02

1961‑1970 0.114D+00 ‑.215E+03  1971‑1990 ‑.742D‑01  0.158E+03  1982  0.409   1.884D‑01

1961‑1971 0.139D+00 ‑.264E+03  1972‑1990 ‑.101D+00  0.210E+03  1980  0.319   2.397D‑01

1961‑1972 0.138D+00 ‑.262E+03  1973‑1990 ‑.140D+00  0.288E+03  1981  0.306   2.780D‑01

1961‑1973 0.241D+00 ‑.464E+03  1974‑1990 ‑.119D+00  0.248E+03  1976  0.105   3.604D‑01

1961‑1974 0.285D+00 ‑.550E+03  1975‑1990 ‑.996D‑01  0.209E+03  1974  0.011   3.842D‑01

1961‑1975 0.270D+00 ‑.521E+03  1976‑1990 ‑.109D+00  0.227E+03  1975  0.002   3.788D‑01

1961‑1976 0.249D+00 ‑.479E+03  1977‑1990 ‑.128D+00  0.264E+03  1976  0.000   3.763D‑01 1961‑1977 0.253D+00 ‑.488E+03  1978‑1990 ‑.105D+00  0.219E+03  1975  0.060   3.577D‑01

1961‑1978 0.255D+00 ‑.493E+03  1979‑1990 ‑.537D‑01  0.117E+03  1973  0.161   3.091D‑01

1961‑1979 0.228D+00 ‑.438E+03  1980‑1990 ‑.540D‑01  0.118E+03  1974  0.172   2.817D‑01

1961‑1980 0.206D+00 ‑.395E+03  1981‑1990 ‑.440D‑01  0.982E+02  1974  0.203   2.497D‑01

1961‑1981 0.174D+00 ‑.333E+03  1982‑1990 ‑.102D+00  0.214E+03  1978  0.115   2.767D‑01

1961‑1982 0.156D+00 ‑.298E+03  1983‑1990 ‑.135D+00  0.279E+03  1979  0.089   2.917D‑01

1961‑1983 0.146D+00 ‑.277E+03  1984‑1990 ‑.122D+00  0.254E+03  1979  0.123   2.683D‑01

1961‑1984 0.139D+00 ‑.264E+03  1985‑1990 ‑.119D‑01  0.343E+02  1973  0.364   1.512D‑01

1961‑1985 0.125D+00 ‑.236E+03  1986‑1990 0.422D‑01  ‑.733E+02  1964  0.713   8.263D‑02

1961‑1986 0.106D+00 ‑.198E+03  1987‑1990 ‑.182D+00  0.372E+03  1983  0.095   2.874D‑01

1961‑1987 0.919D‑01 ‑.171E+03  1988‑1990 ‑.832D+00  0.167E+04  1988  0.025   9.243D‑01

1961‑1988 0.892D‑01 ‑.166E+03 1989‑1990 ‑.125D+01 0.249E+04  1988 0.013   1.334D+007

                                              Figure 4.4d : Log file after performing trend analysis


The method iteratively calculates 2 regression equations at a time: one from the first year in the time series, i to i+1, and the second from i+2 until the last year in the time series.  Using this example, the program calculates a regression equation from 1961 to 1962 and then from 1963 until 1990.  The program also calculates the year when these two lines intersect (Itcp), the difference between the year i and Itcp, referred to as delta, and the difference between the slopes of the two equations, m1-m2.  If the two lines intersect outside the range of the trend variable (for instance, before 1960 or after 1990 in the example of fig. 4.4a), the intersect is given as "O.O.R", "out of range".  This information can then be used to calculate the trend changes and the types.  Using the differences between the slope and the values of the intercepts of each equation, this will indicate trend changes of the first type.  Trend changes of the second type occur when delta passes through a minimum.  


At the top of the output file is a list of the variables found in the input file, the extreme values of the variables and the number of data points with missing data.  In addition, it indicates when (during which year) the two lines intersect (Itcp), and delta, the difference between i and Itcp.  This is followed by a large matrix containing 9 columns.  The first six refer to the regression equations calculated iteratively by the program; m is the slope and p is the intercept.  The last three columns list the intersection point, the delta and the difference between the two slopes.  Notice that delta reaches a minimum at 1976 and indicates a trend change of the second kind.  No trend changes of the first kind occur here.


If no trend variable is given, the input matrix is assumed to be sorted (e.g., increasing years).  Otherwise, the program sorts the data by increasing values of the "trend variable".  Thus, for instance, it is possible to invert the matrix if there is a trend change of yield vs. elevation, or rainfall vs. latitude.  

It is also clear that identical values of the trend variable would lead to points being superposed in fig.4.4e, in which case there can be no intersection of lines.  Such cases are skipped by the program, which results in some values of the trend variable missing from the output table, e.g., 1-3 3-end with having 1-2 2-end.
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Figure 4.4e
4.5 Matrix Transposition

In a world of unstandardized data formats, one is often faced with the problem of incompatible files.  One simple but common example of incompatibility is the way in which the data of your matrix are arranged, i.e., what variables constitute your rows and which your columns.  To solve this problem, your matrix needs to be transposed.

For example, take the file previously displayed in fig.4.1a.  The rows are composed of station names and the columns are 8 geographical, agrometeorological and remote sensing variables.  Suppose that you had a program which requires you to list the stations in each column.  Load the file into FAOMET and activate this option by selecting Transpose from the Stagmet menu.  The data will be transposed and the output written to the file SA_SA-M3.DAT, shown in fig.4.5a.  The log file indicates only the option activated and the output file.  

PRIVATE 
"Transpose from C:\TESTDATA.FAO\SA‑MALI.DAT"

"","Bafoulabe","Banamba","Bandiagara","Bankass","Baraoueli","Bla","Bougouni",

"NDVI26",187,165,144,157,175,170,183,

"IND",92.6,92.3,86.1,90.7,95.4,97.1,97.6,

"YLD",843,602,431,472,755,838,395,

"LON",‑10,‑7.3,‑3.7,‑3.6,‑6.5,‑5.9,‑7.3,

"LAT",14,13.7,14.5,13.5,13,12.9,11.2,

"LGS",115,121,94,116,125,125,161,

"NormRain",1027,914,517,749,987,814,1297,

"PTB28",126,119,96,103,128,128,124,8
                                                     Figure 4.5a : SA_SA-M3.DAT file

4.6 Calculating Rainfall Probabilities from an Incomplete Gamma Distribution

Rainfall is responsible for most of the year-to-year variability in crop yields in many developing countries.  If the varieties used are locally-adapted, the output will be normal whenever the rains are normal, given no other limiting factors such as pests or diseases.


When working operationally with rainfall data, one is often interested in knowing whether the rainfall recorded was unusually high or low.  This can only be assessed by comparing the current rainfall with historical rainfall records covering a period of many years.  Take the rainfall record for Rome, which goes from 1782 to 1980, as an example.  Suppose that the rainfall recorded in June 1981 was the lowest ever registered during that month.  We can say that the rainfall received was exceptionally low and that rain fed crops in the field were likely to have suffered a severe water shortage, i.e., drought conditions.  


A very high (or low) amount of rain that occurs, on average during a few years every century, is said to have a very low probability of occurrence.  This is usually expressed as the probability of exceedence (P) of a given amount of rainfall.  If P is below 5%, it means that rainfall was exceptionally high, since it will be exceeded (on average) in only 5 years out of every 100.  Likewise, values above 95% correspond to exceptionally dry conditions.  The probability range from 5 to 20 and from 80 to 95 is termed unusual and values from 21 to 79 are considered normal.  


This option calculates rainfall probabilities based on the incomplete gamma distribution which best approximates the positively skewed rainfall distribution of tropical countries, for short periods of a month or less.  By integrating the area under the curve between 0 and the probability of exceedence desired, one can determine the rainfall threshold.


Load the sample file SG-ROME.DAT listed partially in Figure 4.6a.  The file contains monthly rainfall time series data for Rome, from 1782 to 1980.  Years are listed along the rows and the columns are the months.  Note that each year is enclosed in quotes or the program will treat them as regular numbers and include them in the probability calculations.  The order of the columns is not important, so the columns could cover July through June, and data can belong to different stations.

PRIVATE 
"Rome rainfall from 1782 to 1980"

"JAN" "FEB" "MAR" "APR" "MAY" "JUN" "JUL" "AUG" "SEP" "OCT" "NOV" "DEC" "YEAR" 

"Y‑1782" 33 107 22 126 27 42 8 0 41 176 133 52 767 

"Y‑1783" 94 96 64 56 69 65 8 6 71 122 16 140 807 

"Y‑1784" 162 134 71 51 40 45 6 3 17 308 103 181 1121 

"Y‑1785" 66 88 48 63 10 15 5 2 0 68 149 175 689 

"Y‑1786" 121 48 55 83 31 35 11 12 5 35 127 78 641 

"Y‑1787" 43 40 92 61 126 33 6 0 29 55 126 44 655 

"Y‑1788" 78 61 199 23 47 27 1 17 52 62 124 154 845 

"Y‑1789" 34 58 173 18 91 12 29 50 16 205 161 57 904 

"Y‑1790" 52 10 30 65 32 75 4 69 41 171 95 78 722 9
                                                        Figure 4.6a : SG-ROME.DAT file

Now select Gamma distribution from the Stagmet menu.  This option first checks that there is no negative data in your input matrix.  If there is, a warning message will be displayed, and the option will end.

Otherwise, the Gamma Distribution window will open, as shown in fig.4.6b.  You are prompted to enter values for the probability table.  Simply type the values into the appropriate text boxes.  For this example, enter 0 for LOW, 200 for HIGH and 20 for STEP.
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                                                          Figure 4.6b Gamma distribution window

Click on the Compute button, and the calculation will be performed, with results being written to the log file.

If you’d like to perform manual calculations, click on the Manual calc. button.  This alters the appearance of the window, to that of fig.4.6c.
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                                              Figure 4.6c : Gamma distribution window 2

Now you are prompted to select the variable for the manual calculation; simply click on the list box and then on the required variable.  For this example, choose JAN.  Now enter the rainfall amount in the appropriate text box.  The probability of the rainfall exceeding this value in January, will now be printed.  

For example, enter 20 for the rainfall amount.  The output shows that, in January, the probability of the rainfall exceeding 20mm is 0.948, ie. 95%.  Note that these manual calculations will not be written to the log file, unless you select the Write results to log file check box.

Fig.4.6d shows the log file after the gamma distribution function have been completed.

PRIVATE 
                Source file: C:\TESTDATA.FAO\SG‑ROME.DAT

                Title: Rome rainfall from 1782 to 1980

                                  List of variables

              Nr   Name           Number missing   Minimum        Maximum

               1   JAN                  1           4              227 

               2   FEB                  1           0              218 

               3   MAR                  1           0              199 

               4   APR                  1           0              228 

               5   MAY                  1           0              148 

               6   JUN                  1           0              139 

               7   JUL                  2           0              113 

               8   AUG                  2           0              106 

               9   SEP                  2           0              260 

               10  OCT                  2           6              346 

               11  NOV                  2           6              372 

               12  DEC                  2           0              273 

               13  YEAR                 2           316            1465 

       Complete data lines:  199  / Code for missing data: ‑999 

------------------------Incomplete gamma law, option SG------------------------

                         Parameters of gamma Distribution

         JAN   FEB   MAR   APR   MAY   JUN   JUL   AUG   SEP   OCT   NOV   DEC  YEAR

# years  198   198   198   198   198   198   197   197   197   197   197   197   197

# zeros    0     5     4     2     3     7    37    22     5     0     0     1     0

Beta   30.10 39.73 28.35 31.78 28.30 33.18 21.76 25.09 44.40 55.66 41.73 42.21 40.63

Gamma   2.67  1.72   2.52  1.99  1.92  1.11  0.94  1.15  1.47  2.11  2.65  2.31 19.74

Average  80.4  66.8  70.2  62.7  53.7  35.8 16.7  25.7  63.9 117.7 110.9 97.3 802.1

    Gamma values between brackets are likely to yield meaningless probabilities!

                   Probability that given amount will be exceeded

AMOUNT    JAN   FEB   MAR   APR   MAY   JUN   JUL   AUG   SEP   OCT   NOV   DEC  YEAR

  0.0 |  1.000 0.975 0.979 0.989 0.984 0.964 0.812 0.888 0.974 1.000 1.000 0.994 1.000

 20.0 |  0.948 0.836 0.907 0.858 0.812 0.582 0.305 0.463 0.798 0.959 0.974 0.948 1.000

 40.0 |  0.790 0.633 0.718 0.633 0.555 0.334 0.118 0.222 0.590 0.861 0.885 0.825 1.000

 60.0 |  0.597 0.453 0.512 0.430 0.347 0.188 0.046 0.105 0.420 0.738 0.756 0.673 1.000

 80.0 |  0.421 0.314 0.341 0.279 0.207 0.105 0.018 0.048 0.293 0.614 0.615 0.525 1.000

100.0 |  0.283 0.212 0.216 0.175 0.119 0.059 0.007 0.022 0.201 0.498 0.483 0.397 1.000

120.0 |  0.184 0.142 0.133 0.107 0.067 0.032 0.002 0.010 0.136 0.397 0.368 0.293 1.000

140.0 |  0.116 0.093 0.079 0.064 0.037 0.018 0.001 0.004 0.092 0.312 0.275 0.212 1.000

160.0 |  0.071 0.061 0.046 0.038 0.020 0.010 0.000 0.002 0.061 0.243 0.201 0.151 1.000

180.0 |  0.043 0.039 0.026 0.022 0.011 0.005 0.000 0.001 0.041 0.187 0.145 0.106 1.000

200.0 |  0.026 0.025 0.015 0.013 0.005 0.003 0.000 0.000 0.027 0.143 0.103 0.074 1.000
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Figure 4.6d : Log file after performing gamma distribution

The log file contains the list of variables followed by the statistics of the gamma distribution (Gamma and Beta) together with the number of years, the number of years with no rain (number of zeros), and the long-term average.  This is followed by a probability of exceedence table, listing the rainfall amounts ranging from 0 to 200 on the left-hand side followed by the probabilities.


Gamma values between zeros are likely to yield meaningless probabilities.  This happens with extreme cases of data statistical distributions, for instance, when this option is run on the ST-CHINA.DAT file.

4.7 Geographic Interpolation for the Estimation of Missing Data


A common problem in dealing with meteorological data is missing values for a given time period, e.g., a missing dekad or missing data for a complete station.  Suppose we are missing the normal annual rainfall for the station Aioun_El_Atrouss in Mauritania but the data are available from several neighbouring stations.  The missing rainfall for this station can be obtained by calculating a weighted average of rainfall from the neighbouring stations.


To try this out, open the sample file SI-LGS.DAT.  This file (shown in fig. 4.7a) consists of station information, length of the growing period and the normal annual rainfall for several stations in Mauritania and Mali.

PRIVATE 
    LGS and Normal rain, Mali and surrounding areas. Adm=admin units.

                        Lon.     Lat.     Alt.     LGS      NormRain

    Same              ‑11.59    14.49       39       88      527

    Kayes             ‑11.44    14.44       47      111      723

    Tidjikja          ‑11.44    18.57      402        0      143

    Kiffa              ‑11.4    16.64      115       70      352

    Kenieba           ‑11.24    12.85      132      154     1408

    Adm‑Kenieba        ‑11.1       13      150      150     ‑999

    Adm‑Kayes            ‑11     14.5       90     ‑999     ‑999

    Adm‑Yelimane       ‑10.5     15.3      280     ‑999     ‑999

    Adm‑Bafoulabe        ‑10       14      200     ‑999     ‑999

    Aioun_El_Atrouss    ‑9.6     16.7      223       53      316

    Adm‑Kita            ‑9.5     13.5      300     ‑999     ‑999

    Adm‑Diema           ‑9.5     14.5      280     ‑999     ‑999

    Adm‑Nioro           ‑9.5     15.4      250     ‑999     ‑999

    Kita               ‑9.47    13.07      333      137     1142

    Nioro              ‑9.35    15.24      237       91      631

    Kourousa           ‑9.25    10.65      372      179     1504

    Adm‑Kangaba         ‑8.5     11.8      280     ‑999     ‑999

    Bamako             ‑8.04    12.64      332      137     1075

    Adm‑Yanfolila         ‑8     10.9      280     ‑999     ‑999

    Adm‑Kati              ‑8     12.5      280     ‑999     ‑999

    Adm‑Kolokani          ‑8     13.7      280     ‑999     ‑999

    Odienne            ‑7.57      9.5      421      219     1612
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Figure 4.7a : SI-LGS.DAT file

Select Interpolate from the Stagmet menu.  The Geographic interpolation window will appear, as shown in fig. 4.7b.

You are presented with a number of parameters and options to specify.  These are explained below:


• MAXIMUM nr. of neighbours used - allows you to change the maximum number of


neighbouring stations to be used in the interpolation.  The default value is set at 10

and means that only the 10 nearest stations will be used in the interpolation.  This


option should be used with care when interpolating PET and it is suggested to reduce

this number drastically.
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                                             Figure 4.7b : Geographic interpolation window


• MINIMUM nr. of neighbours used - lets you set the minimum requirement for the

number of surrounding stations used in the interpolation.  The default value is 1,

meaning that at least one neighbouring station is required for the interpolation.  If no
stations are found within the "radius of action" (option R), no value will be

interpolated.


• Radius of action (km) - allows you to choose the "radius of action", i.e., the greatest


distance beyond which a station is assumed not to be relevant for the interpolation,

and is set to a default value of 120 km.  The program computes distance in kilometres

based on the geographic coordinates, and corrections are applied for the change in

length of one degree.


• Power for weighting - lets you apply a weighting factor.  The greater the factor, the less
influence points
further out will have on the interpolation.  If set to 0, the estimated
value will be the arithmetic mean.


• Format for coordinates - allows you to choose the format of your station coordinates,

 
either degree-minutes or decimal-degrees.  


• Nr. of decimals in result - lets you decide on the number of decimal places in your


interpolated result, ranging from 1 to 3.


• Zero negative results? - lets you decide whether negative interpolated values should be set
to zero.
 When working with rainfall data, for instance, negative numbers are

meaningless and this option should be activated.


• Correct for elevation - allows you to include a correction for the systematic influence of
altitude.  In general, there is a decrease in the temperature of 4 to 6 degrees for each
1000 m, so this effect is important to take into account when interpolating missing
data for a mountainous country such as Ethiopia.  The influence of temperature will
be transferred to PET and other agrometeorological parameters when computed.

These parameters are altered either by typing the desired value into the appropriate text box, or, in the case of those with only two possible values, by clicking on the small square toggle button (<<) to the right of the text.  You can set all parameters back to their default values by clicking on the 

Default vals. button.

Click on the Proceed button, and the window will change, as shown in fig. 4.7c.
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                                               Figure 4.7c : Geographic interpolation window 2


The program tries to guess which variables are being used for latitude and longitude (and possibly altitude if the correct for elevation option was selected) by their names.  It’s guesses are displayed in the two (or three) boxes at the top of the window.  If the default variables are not correct, click on the appropriate box, then select the correct variable from the list which appears.

Now you must select the variables for which you want to interpolate missing data.  Simply click on the required variables in the list box.  The Clear and All buttons may be used to speed up this process if you have a long list of variables.

When you have done this, click on the Compute button.  The program now performs the calculations.

After finishing, the output is written to the file SI_SI-L1.DAT (shown in fig. 4.7d).  Compare the stations in fig. 4.7a of the input file that had missing data with the interpolated answers in the output file.

PRIVATE 
"Estimates from 4 to 10 neighbours; Power= 1.5; Radius= 300;no Z‑correction"

"","Lon.","Lat.","Alt.","LGS","NormRain"

"Same",‑11.59,14.49,39,88,527

"Kayes",‑11.44,14.44,47,111,723

"Tidjikja",‑11.44,18.57,402,0,143

"Kiffa",‑11.4,16.64,115,70,352

"Kenieba",‑11.24,12.85,132,154,1408

"Adm‑Kenieba",‑11.1,13,150,150,1321.2

"Adm‑Kayes",‑11,14.5,90,107.9,749.7

"Adm‑Yelimane",‑10.5,15.3,280,100.3,703.5

"Adm‑Bafoulabe",‑10,14,200,120.2,925.2

"Aioun_El_Atrouss",‑9.6,16.7,223,53,316

"Adm‑Kita",‑9.5,13.5,300,127.2,1016.6

"Adm‑Diema",‑9.5,14.5,280,110.1,822.9

"Adm‑Nioro",‑9.5,15.4,250,93.9,655.6

"Kita",‑9.47,13.07,333,137,1142

"Nioro",‑9.35,15.24,237,91,631

"Kourousa",‑9.25,10.65,372,179,1504

"Bamako",‑8.04,12.64,332,137,1075
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Figure 4.7d : SI_SI-L1.DAT file

You will notice that the station Aioun-El-Atrouss now has an interpolated value of normal annual rainfall of 316mm.

4.8 Data Interpolation

Suppose we have a set of measured data, in this case data on the weight, leaf area and growth rate of Badischer Frueh maize measured on various days (expressed by the Julian day number).  A portion of the sample data set, SY-GRWTH.DAT, is shown in fig. 4.8a:  

PRIVATE 
"'Badischer Frueh' maize, after Kreusler (1879) in Hunt, 1982"

"DayNr","gramDW/plant","sqmleaf/plant","growthg/(day.plant)"

140,0.3282, ‑999,0,

148,0.328, ‑999,0,

155,0.287, ‑999,‑0.01,

162,0.255,0.00179,0,

169,0.308,0.00292,0.01,

176,0.637,0.01244,0.05,

183,2.319,0.04192,0.24,

190,4.654,0.07622,0.33,

197,9.019,0.1301,0.62,

204,20.001,0.2136,1.57,

211,34.557,0.2805,2.08,

218,57.587,0.3384,3.29,

225,70.095,0.3047,1.79,

232,85.165,0.3025,2.15,

239,111.649,0.2976,3.78,

246,124.76,0.2684,1.87,

253,121.99,0.2387,‑0.4,
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Figure 4.8a : SY-GRWTH.DAT file
Although we know the value of the weight on Julian day 140 and 148, since we took measurements on these days, we are interested in the weight on day 144, but unfortunately do not have an analytic expression that allows us to calculate the weight on any given day.  To solve this, we employ the method referred to as cubic spline interpolation.  This essentially draws a curve through all the data points and then determines the values of the function at the points desired.  The reader is referred to Flannery et al., 19** [**] for a detailed explanation of the method.


Open the sample input file SY-GRWTH.DAT, then click on Interpolate Y-X from the Stagmet menu.  A window, like that shown in fig. 4.8b, will appear.  
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                                                                 Figure 4.8b : Data interpolation window

The program automatically assumes that the X variable, i.e., the Julian day, is in column #1,  and that the Y variable is in column #2.  If this is not the case in your dataset, you must select the correct X and Y variables yourself, by clicking on the appropriate boxes and selecting the variable from the list. 

The MINIMUM and MAXIMUM X values will now be displayed, along with a STEP value.  You are free to change any of these values.  Clicking on the small button (<<) next to the STEP value will automatically calculate an appropriate STEP from the given max. and min. values.  Clicking on the Default vals. button will set all the values back to their defaults.  For this example, set the STEP to 1, since the Julian day is an integer value.  

Now click on the Compute button, and the calculation will take place.

The output is written only to the log file (see fig. 4.8c); it contains the variables, their maximum and minimum values, followed by two columns: the Julian days with a time step of a day, and the resulting splined values.

PRIVATE 

Title: 'Badischer Frueh' maize after Kreusler (1879) in Hunt 1982

                                  List of variables

              Nr   Name           Number missing   Minimum        Maximum

               1   DayNr                0           140            253 

               2   gramDW/plant         0           .255           124.76 

               3   sqmleaf/plant        3           .00179         .3384 

               4   growthg/(day.pla     0          ‑.4             3.78 

       Complete data lines:  17  / Code for missing data: ‑999 

Interpolated Y‑values...

              Spline...

                   X=DayNr             Y=gramDW/plant

                   ----------------------------------------

                    140                 .3282 

                    141                 .3296255 

                    142                 .3309128 

                    143                 .3319238 

                    144                 .3325205 

                    145                 .3325645 

                     "                     "      

                     "                     "

                    247                 125.0707 

                    248                 125.0553 

                    249                 124.7683 

                    250                 124.2639 

                    251                 123.5965 

                    252                 122.8204 

                    253                 121.99 
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Figure 4.8c : Log file after data interpolation
5 AGROMET OPTIONS
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In addition to several statistical options, FAOMET offers several agrometeorological techniques used in the monitoring of the agricultural season.  The same format has been adopted as in the previous chapter and you are once again encouraged to work through the options with the sample files provided on the diskette. 

5.1 Calculating Daytime and Night-time Temperatures

In addition to minimum and maximum temperatures, daytime and night-time temperatures are also important climate variables, for example, in the assessment of optimal growing conditions and for the calculation of maximum and reference yields.  Add some facts here.... 


The two parameters are derived, calculated from a routine by Petricevic and given in more detail in Gommes [x].  Temperature is assumed to vary smoothly and is modelled with 2 cosine curves which have their maximum and minimum points at the time of maximum and minimum temperature.  The assumptions are that minimum temperature occurs at sunrise whereas maximum occurs one hour after local noon.  Given the day number in the year and the latitude, the day length at a particular station can be calculated.  To calculate the daytime and night-time temperatures, the area under the portion of the 2 cosine curves corresponding to day and night, respectively, is calculated and divided by the day and night length to calculate the average day and night-time temperature.


Four variables are thus required to run this option: maximum and minimum temperatures, latitude and the day number or month, which is listed in the sample file, AT-ARTEM.DAT, shown in fig. 5.1a. 

PRIVATE 
"Some Agentinian stations..."

" ","WMO‑#","LON","LAT","ALT","Month","Rain","Tmax","Tmin","Vap","Wind","Frac",

"Rivadavia",87.065,‑62.54,‑24.1,205,1,121,35.9,21.4,0.89,2,0.67,

"Rivadavia",87.065,‑62.54,‑24.1,205,2,102,34.2,21,0.92,1.8,0.7,

"Rivadavia",87.065,‑62.54,‑24.1,205,3,87,33,19.5,0.82,1.8,0.66,

"Rivadavia",87.065,‑62.54,‑24.1,205,4,55,27.6,15.3,0.56,1.6,0.49,

"Rivadavia",87.065,‑62.54,‑24.1,205,5,17,25.1,12.3,0.35,1.8,0.5,

"Rivadavia",87.065,‑62.54,‑24.1,205,6,8,22.8,10.7,0.28,1.8,0.43,

"Rivadavia",87.065,‑62.54,‑24.1,205,7,6,24.6,9.5,0.29,2,0.64,

"Rivadavia",87.065,‑62.54,‑24.1,205,8,7,27.5,10.6,0.32,2,0.68,

"Rivadavia",87.065,‑62.54,‑24.1,205,9,13,30.5,14.2,0.44,2.2,0.63,

"Rivadavia",87.065,‑62.54,‑24.1,205,10,38,32.5,17.8,0.58,2.4,0.56,

"Rivadavia",87.065,‑62.54,‑24.1,205,11,81,33.9,19.4,0.73,2.2,0.6,

"Rivadavia",87.065,‑62.54,‑24.1,205,12,119,34.8,20.5,0.84,2,0.6,
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Figure 5.1a : AT-ARTEM.DAT file

Open the sample file and click on Temperatures from the Agromet menu.  A window, similar to that shown in fig. 5.1b, will appear.
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                                                 Figure 5.1b : Calculate temperatures window


The program has attempted to guess which variables correspond to the four it is looking for.  If it has guessed any of these incorrectly, simply click on the appropriate box and then select the correct variable.  (If you do not require a Day variable, set it to [none], and the program will automatically use a value of 15.)

You are also given the option of altering two parameters used for the output data: the number of decimal places in the calculated temperatures and the format of the geographic co-ordinates, either in decimal degrees (DD.dd) or degree-minutes (DD.mm).  Change these by either typing the value directly into the box (in the case of decimal places), or by clicking on the small toggle button (<<) beside the coordinate format box.  For this example, change the coordinates format to DD.mm.

Now click on the Calculate button to perform the calculation.

The output will be written to the file AT_AT-A1.DAT (see fig. 5.1c).  Missing data, which prevent the calculations from being carried out, are printed into the log file, together with a message indicating which variable is missing, and from which line of the input matrix.

In addition, the program performs a check of the data and rejects unrealistically low or high data, inconsistent maxima and minima, etc.

PRIVATE 
"Day and nighttime temperatures "

" ","MaxTemp","MinTemp","Latitude","Month","Day","DL(hours)","DayTemp","NightTemp"

"Rivadavia",35.9,21.4,‑24.1,1,15,13.4,31.1,25.5

"Rivadavia",34.2,21,‑24.1,2,15,12.9,29.9,24.9

"Rivadavia",33,19.5,‑24.1,3,15,12.2,28.7,23.7

"Rivadavia",27.6,15.3,‑24.1,4,15,11.5,23.7,19.4

"Rivadavia",25.1,12.3,‑24.1,5,15,10.9,21,16.7

"Rivadavia",22.8,10.7,‑24.1,6,15,10.6,19,15

"Rivadavia",24.6,9.5,‑24.1,7,15,10.7,19.8,14.8

"Rivadavia",27.5,10.6,‑24.1,8,15,11.2,22.1,16.3

"Rivadavia",30.5,14.2,‑24.1,9,15,11.9,25.3,19.5

"Rivadavia",32.5,17.8,‑24.1,10,15,12.6,27.8,22.3

"Rivadavia",33.9,19.4,‑24.1,11,15,13.2,29.2,23.6

"Rivadavia",34.8,20.5,‑24.1,12,15,13.6,30.1,24.5
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Figure 5.1c : AT_AT-A1.DAT file
5.2 Interpolating Dekad Normals from Monthly Values

Operational agrometerology often uses the dekad or 10-day total as its time period for monitoring, which usually involves comparing the current situation to the "normal" one, i.e., a 30-year or longer average.  Since published normals are usually monthly values, a function is needed which interpolates these normals to shorter dekadal periods.


This option works on the assumption that, averaged over long periods, the weather elements typically assume the shape of smooth curves when plotted against time.  The year-to-year variability is cancelled out, particularly when the time units are months or even dekads.  For periods shorter than one dekad, very long periods are required and the concept of climatological normal no longer applies. The normals are particularly misleading for rainfall since they do not represent the expected or most likely value and this fact should be kept in mind when interpreting the data. 


This option fits a parabolic curve through the monthly point data and either calculates the area under the curve for a given dekad if the weather element is a sum (e.g., rainfall, PET and total sunshine hours), or calculates the average (i.e., the sum under the curve divided by the time) for weather elements that are averages (e.g., temperatures and wind speed).

Examine the input file AN-ARRN.DAT, shown in fig. 5.2a.  

PRIVATE 
"Argentina, rainfall data"

" ","Jan","Feb","Mar","Apr","May","Jun","Jul","Aug","Sep","Oct","Nov","Dec"

"Rain‑87.065",121,102,87,55,17,8,6,7,13,38,81,119

"Rain‑87.007",88,70,45,7,0,0,0,0,2,9,27,64

"Rain‑87.035",207,211,141,43,19,14,8,9,12,62,98,149

"Rain‑87.047",176,145,106,30,7,2,2,3,6,26,57,128

"Rain‑87.048",132,93,63,16,3,2,1,1,5,13,41,90
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Figure 5.2a : AN-ARRN.DAT file
The file contains 12 monthly rainfall normals for 5 Argentinian stations from January to December.  The file requires all 12 variables but they can cover either a calendar year (Jan to Dec) or a cropping season (such as July to June).  

To run this option, read the file into memory and click on Normals from the Agromet menu.  A window will appear (as shown in fig.5.2b), requiring you to specfiy if the variable is a monthly total or sum (rainfall, PET, etc.) or an average (average daily PET, temperatures, etc.), if negative results should be assigned a value of zero in cases where negative values are meaningless, and the number of decimals desired in the result; 1 is the default value.  You can change these options by either typing the value into the appropriate box, or by clicking on the toggle button (<<) next to the box.  For this example, change Zero negative results? to YES, since the data are rainfall.
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                                                          Figure 5.2b : Normals window

Click on the Compute button to perform the calculation.

The output is written to the file AN_AN-A1.DAT (see fig. 5.2c), listing the station names followed by the 36 interpolated dekadal values.

PRIVATE 
"Dekad normals from monthly normals"

" ","D1","D2","D3","D4","D5","D6","D7","D8","D9",.... etc. ...,"D35","D36"

"Rain‑87.065",38.3,38.1,41.4,41.6,39.9,30.2,31.5,28.5,27.8,.......,37,42.3

"Rain‑87.007",26.6,27.9,30.7,30,27.8,20,19.7,15.8,12.6,...........,19,24.1

"Rain‑87.035",58.7,63.5,74.1,86,84,62.5,59.2,48.5,40.9,.........,44.3,54.8

"Rain‑87.047",52.8,55.5,61.6,60.8,57.2,42.1,43.3,36.5,..............,38,48

"Rain‑87.048",40.5,42.3,45.7,40.7,36.7,26.1,26.6,21.8,18.2,.......,26.5,34
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Figure 5.2c : AN_AN-A1.DAT file
5.3 Calculating Potential Evapotranspiration (PET)

Potential evapotranspiration (PET) is defined as the maximum quantity of water which is transpired and evaporated by a uniform cover of short dense grass when the water supply is not limited.  PET, together with rainfall data, constitute the main inputs to the soil water balance.  The method used here is based on the modified Penman-Monteith equation, recommended by the Expert Consultation held in Rome in 1991 on this subject (Smith, 1991).


To calculate this variable, several measured weather station data and location specific information are required.  The minimum data requirements are:


• Temperature(s): (average temperature OR both maximum and minimum)


• Air moisture: vapour pressure OR relative humidity


• Sunshine: sunshine hours OR sunshine fraction


• Windspeed at any height


• Station elevation


• Station latitude


• Month

Optional data include the day of the month and the incoming shortwave radiation which, if missing, is estimated from the sunshine fraction and Angstrom's formula:


Rs = Ri * (a + b n/N)

where Rs is the estimated shortwave radiation at station level, Ri is the extra-terrestrial radiation at the top of the atmosphere, n is the hours of bright sunshine as measured with a Campbell-Stokes sunshine recorder, and N is the daylength.  The coefficients a and b have been given the default values of 0.25 and 0.50, corresponding to a tropical climate, and can be changed depending on the location of the station.


Load the file AT-ARTEM.DAT used in the calculation of daytime and night-time temperatures (see fig. 5.1a) and then select Et0 from the Agromet menu.

The Potential evaporation window will appear (as shown in fig. 5.3a), showing the variables the program has guessed to correspond to the required ones.  Check that it has chosen the correct ones.  If not, you can change any which are wrong, by clicking on the appropriate box and selecting the variable from the list which appears.  Note that some variables are optional (Radiation, Day number) whilst others offer a choice between two variables (or two sets of variables), eg. Vapour pressure or Relative humidity; Average temperature or Max. and Min. temperatures.

                                                    Figure 5.3a : Potential evapotranspiration window

Note that if the Radiation variable is not specified, the global radiation will be calculated with Angstrom's formula and sunshine hours, and if Day number is not specified, a value of 15 will be adopted for the calculation of the solar declination.

Once all the variables are selected, click on the Proceed button.  The window changes, to that shown in fig. 5.3b.

                                                Figure 5.3b : Potential evapotranspiration window 2

The screen now lists the default parameters used in the calculation.  Any of them can be changed by either typing a new value in the box, or by clicking on the toggle button (<<) next to the box.

Parameters that may need changing are the a and b coefficients of Angstrom's radiation formula depending on the geographic location of the station, the format of the geographic coordinates (i.e., decimal degrees or degree minutes) and the height of the anemometer in meters.

The parameters can all be reset to their default values by clicking the Defaults button.

When you are happy with the parameters, click the Compute button, and the calculations will be carried out.

The output is written to the file AE_AE-A1.DAT, shown in fig. 5.3c, and consists of the station name, month number (from 1 to 12), daylength (in hours), net radiation (in MJ/m2/day), aerodynamic resistance (in s/m), saturation deficit (kpa), the aerodynmic and radiation components of PET (both in mm/day), and three values of PET in mm/day, mm/month and mm/dekad.

PRIVATE 
"Penman‑Monteith Ref. Crop ET with  Albedo= .23 for Grass"

"","Lat","M#","Day","DL(hours)","QN(MJ/sqm/day)","ra(s/m)","SD(kPa)",AT(mm/day)

"RadTerm(mm/day)","ET0(mm/day)","ET0(mm/month)","ET0(mm/dekad)"

"Rivadavia",‑24.16667,1,15,13.43,19.17,103.83,3.34,0,3.64,3.64,112,36

"Rivadavia",‑24.16667,2,15,12.87,18.43,115.37,3.01,0,3.4,3.4,95,34

"Rivadavia",‑24.16667,3,15,12.23,15.88,115.37,2.83,0,2.69,2.69,83,27

"Rivadavia",‑24.16667,4,15,11.51,11.28,129.79,2.16,0,1.63,1.63,48,16

"Rivadavia",‑24.16667,5,15,10.93,9.42,115.37,1.96,0,1,1,31,10

"Rivadavia",‑24.16667,6,15,10.61,7.81,115.37,1.75,0,0.72,0.72,21,7

"Rivadavia",‑24.16667,7,15,10.74,9.99,103.83,1.85,0,0.81,0.81,25,8

"Rivadavia",‑24.16667,8,15,11.24,12.23,103.83,2.15,0,1.26,1.26,39,13

"Rivadavia",‑24.16667,9,15,11.92,14.2,94.39,2.55,0,1.93,1.93,57,19

"Rivadavia",‑24.16667,10,15,12.61,15.44,86.53,2.88,0,2.5,2.5,77,25

"Rivadavia",‑24.16667,11,15,13.25,17.58,94.39,3.04,0,3.14,3.14,94,31

"Rivadavia",‑24.16667,12,15,13.58,18.21,103.83,3.15,0,3.46,3.46,107,35
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Figure 5.3c : AE_AE-A1.DAT file
5.4 Calculating the Length of the Growing Period (LGP)


The length of the growing period (LGP), as defined by the Agro-Ecological Zones project carried out at FAO during the last two decades [refs], is the period (in days) during a year when precipitation exceeds half the potential evapotranspiration, plus a period required to evapotranspire an assumed 100 mm of water from excess precipitation stored in the soil profile.  


The LGP is a useful concept for calculating agricultural potential, and can be used as a criterion for classifying areas and in roughly determining crop cycle lengths.  The calculation of the growing period is based on a simple water balance model, comparing precipitation with PET, using monthly values.

A "normal" growing period, pictured in fig.5.4a, has the following characteristics:


(1)  A Beginning


The beginning coincides with the start of the normal rainy season and is taken as the date when precipitation equals half PET, denoted as a in fig.5.4a.  A value of 1/2 PET has been chosed because the water requirements of germinating crops are much below the full rate of PET, reflected clearly in the magnitude of the crop coefficients, and false starts to the rainy season are eliminated.


(2)  A Humid Period



This is the period during which precipitation exceeds PET.  The beginning and ending dates (shown as b and c in fig.5.4a, respectively) are the two points where the precipitation and PET curves cross.  



During this period, crops are able to meet their full water requirements and the soil moisture deficit is replenished.  The ending date of the humid period coincides with the end of the rainy season and crops mature largely from water stored in the soil.


(3)  An End to the Growing Period


This occurs at the point where the precipitation curve crosses the 1/2 PET curve (labeled as d in fig. 5.4a) and takes into consideration that most crops continue to grow beyond the end of the rainy season.  



The soil water-holding capacity (defined as....) is assumed to be 100 mm and the time taken to deplete the remaining soil reserves at the end of the season is added on to the LGP.  In a future version, there will be an option to change this value.

In addition to a normal period, three other types of growing periods can be defined:


(1)  Intermediate Growing Period


Throughout the year, the average monthly precipitation does not exceed the full rate of the average monthly PET, but it does exceed half the PET.  The beginning and the end of such an intermediate growing period are defined as the points where the precipitation curve crosses the 0.5 PET curve and there is no humid period.


(2)  All Year Round Humid Growing Period


The average monthly pptn, for every month of the year, exceeds the full rate of the average monthly PET.  Thus, there is no true start to the growing period or to the humid period.  Areas with all year round humid growing periods have been included and inventoried as areas with a normal growing period of 365 days.


(3)  All Year Round Dry Period


The average monthly precipitation for every month of the year is lower than half the average monthly PET.  Areas with all year round dry periods have been inventoried separately as areas with a growing period of 0 days.
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Figure 5.4a


Examine the sample data file, AL-LGP.DAT, shown in fig. 5.4b.  The file contains station names in Africa, geographical coordinates between 2 North and 2 South, and 12 monthly values of rainfall and PET for each station.  Notice that the input file requires the rainfall and PET to appear on the same line.

PRIVATE 
"Rainfall and PET from 67 stations between‑2 and 2 degs. latitude" "Lon","Lat","Alt","R1","R2","R3","R4","R5","R6","R7","R8","R9","R10","R11","R12","E1","E2","E3","E4","E5","E6","E7","E8","E9","E10","E11","E12"

"GOMA‑ZAI",29.14,‑1.41,1552,115,86,98,126,129,45,28,66,110,149,136,117,110,101,113,102,105,111,116,115,120,117,113,103

"GABIRO‑RWA",30.24,‑1.32,1472,65,78,95,155,78,18,19,19,68,82,72,75,121,113,126,117,118,122,130,133,139,124,120,116

"MACHAKOS‑KEN",37.17,‑1.31,1680,49,53,124,210,76,12,5,6,9,53,189,122,149,140,145,118,110,100,93,92,126,136,127,122

"GALOLE‑KEN",40.02,‑1.3,100,35,19,34,56,30,20,21,13,49,38,94,61,152,151,164,151,150,132,136,145,166,152,146,137

"KITUI‑KEN",38.01,‑1.22,1090,41,24,118,244,56,5,3,5,6,82,304,143,151,154,165,127,124,117,114,130,150,161,134,126

"RUMANGAB‑ZAI",29.22,‑1.21,1620,114,115,170,216,156,112,83,140,193,203,200,154,104,95,108,98,98,96,103,97,106,100,99,95

"NAIROBI‑KEN",36.55,‑1.19,1624,63,34,81,107,130,24,7,11,21,62,188,116,147,151,156,122,107,97,92,90,110,125,121,122

"NAIROBI‑KEN",36.45,‑1.18,1798,55,43,87,190,175,41,15,24,20,46,136,83,133,131,141,114,95,86,79,85,109,126,116,116

"KABETE‑KEN",36.45,‑1.16,1820,47,51,100,210,171,44,19,26,29,60,127,93,144,140,142,112,97,81,80,85,115,126,120,121

"KABETE‑KEN",36.46,‑1.15,1820,32,49,102,222,164,46,15,26,30,55,103,87,139,138,142,112,96,85,82,87,114,122,113,116

"MASARA‑KEN",34.15,‑1.01,1200,51,79,120,235,198,94,36,62,93,114,151,117,145,137,147,123,123,115,121,128,152,144,134,126

"THIKA‑KEN",37.06,‑1.01,1463,33,30,96,213,130,25,15,18,17,60,145,76,149,157,157,125,110,98,92,93,123,135,130,124

"ORICHING‑UGA",30.47,‑0.52,1280,56,95,179,240,116,32,25,147,169,56,148,128,103,99,110,93,96,93,102,101,108,100,97,91
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Figure 5.4b : AL-LGP.DAT file

Open the sample file and select Lgp from the Agromet menu.  A window appears and you will immediately be prompted to accept or change the default value of 1/2 PET to define the beginning and the end of the growing season as given in the original AEZ definition.  The value can be changed by simply typing a new value into the box.  But for this example, accept the value and click on the Compute button to perform the calculation.

 The output is written to the file AL_AL-L1.DAT, partially shown in fig.5.4c.

PRIVATE 
"Length of growing season with F= .5"

,"La","Lo","Alt","SeasTot","Nr","Type","LGS","BegSd.m","BegSJul","EndSd.m","BegHd.m","EndHd.m"

"GOMA‑ZAI", 29.14 ,‑1.41 , 1552 , 1 , 1 , 3 , 231 , 9.08 , 221 , 27.03 , 23.09 , 23.01 

"GABIRO‑RWA", 30.24 ,‑1.32 , 1472 , 1 , 1 , 3 , 250 , 18.09 , 261 , 25.05 , 29.03 , 1.05 

"MACHAKOS‑KEN", 37.17 ,‑1.31 , 1680 , 2 , 1 , 3 , 93 , 23.02 , 54 , 26.05 , 21.03 , 7.05 

"MACHAKOS‑KEN", 37.17 ,‑1.31 , 1680 , 2 , 2 , 3 , 81 , 19.1 , 292 , 7.01 , 3.11 , 16.12 

"GALOLE‑KEN", 40.02 ,‑1.3 , 100 , 1 , 1 , 2 , 34 , 5.11 , 309 , 8.12 ,‑999 ,‑999 

"KITUI‑KEN", 38.01 ,‑1.22 , 1090 , 2 , 1 , 3 , 84 , 15.1 , 288 , 6.01 , 25.1 , 20.12 

"KITUI‑KEN", 38.01 ,‑1.22 , 1090 , 2 , 2 , 3 , 74 , 3.03 , 62 , 15.05 , 24.03 , 4.05 

"RUMANGAB‑ZAI", 29.22 ,‑1.21 , 1620 , 1 , 1 , 6 , 340 ,‑999 , 206 ,‑999 , 25.07 , 29.06 

"NAIROBI‑KEN", 36.55 ,‑1.19 , 1624 , 2 , 1 , 3 , 88 , 13.03 , 72 , 8.06 , 27.04 , 23.05 

"NAIROBI‑KEN", 36.55 ,‑1.19 , 1624 , 2 , 2 , 3 , 88 , 16.1 , 289 , 11.01 , 1.11 , 13.12 

"NAIROBI‑KEN", 36.45 ,‑1.18 , 1798 , 2 , 1 , 3 , 105 , 3.03 , 62 , 15.06 , 28.03 , 5.06 

"NAIROBI‑KEN", 36.45 ,‑1.18 , 1798 , 2 , 2 , 3 , 78 , 21.1 , 294 , 6.01 , 9.11 , 27.11 

"KABETE‑KEN", 36.45 ,‑1.16 , 1820 , 2 , 1 , 3 , 114 , 27.02 , 58 , 20.06 , 25.03 , 5.06 

"KABETE‑KEN", 36.45 ,‑1.16 , 1820 , 2 , 2 , 3 , 78 , 17.1 , 290 , 2.01 , 13.11 , 21.11 

"KABETE‑KEN", 36.46 ,‑1.15 , 1820 , 2 , 1 , 3 , 113 , 27.02 , 58 , 19.06 , 23.03 , 5.06 

"KABETE‑KEN", 36.46 ,‑1.15 , 1820 , 2 , 2 , 2 , 72 , 19.1 , 292 , 29.12 ,‑999 ,‑999 
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Figure 5.4c : AL_AL-L1.DAT file
The first line of the file lists the limit you choose for determining the beginning and end of the growing season, i.e., 1/2 PET.  This is followed by columns with the station name, latitude, longitude, altitude and several growing season characteristics.  Table 5.4a describes the parameters in the output file and the range of possible answers:


Table 5.4a - Growing Season Characteristics

PRIVATE 
Column Heading
Meaning of the column variable
Range of Answers

Seastot
Seasonal total rainfall (mm)
N.A.

Nr
Number of seasons
1 - single; > 1 - multiple

Type
Type of season
1 - dry; 2 - intermediate; 3 - normal; 6 - normal with no dry period

LGS
Length of the Growing Season (days)
0 to 365

BegSd.m
Beginning of the season (day.month)


BegSJul
Beginning of the season (Julian days)
0 to 365

EndSd.m
End of the season (day.month)


BegHd.m
Beginning of the humid period (day.month)
-999 if no humid period

EndHd.m
End of the humid period (day.month)
-999 if no humid period

Note that for a station with a year round dry period, indicated as 1 under the column "Type", the LGS will be listed as having 365 days instead of 0 days.  This bug will be fixed in future versions.

6 FAOMET UTILITIES
--------------------------------------------------------------
6.1 The Preferences file
The first time FAOMET is run, a preferences file (prefs.txt) is created.  This file holds default values for several parameters used by the program.  You can see their values (and edit them) by clicking on Preferences from the Options menu. The parameters are described below:


Missing data indicator (MDI):







This is the value used by the program to signify missing data.  The default value is –999.





If your data file uses a different value, you will have to change the MDI to reflect this.






This is done by typing a new value into the box.


Text editor:







This specifies which text editor will be used for any options which display text files (eg.





View log file).  Change it by clicking on the box.  A file selector box will appear, from





which you can select a new editor program.


Data directory:    







This specifies the directory where the program will first search when prompting the





user to load an input file.  Change it by clicking on the box, then selecting a new






directory from the selector box.


Startup logfile:







This specifies the name of the log file to be used when the program starts.  Change it





by clicking on the box, and selecting a new filename from the file selector box.


Confirm output file names:

 





Whenever the program is to create a new output file, it makes up a new filename 






by taking the first few characters of the input filename, then adding the two






characters which specify the function being performed (eg. SP for Stagmet-PCA)





and finally adding a number.  Normally the user has no control over this output 






filename, but if you turn on this option (by clicking on the check box), then every time





an output filename is generated, a window appears and gives you the option of






changing it.

Once you have finished changing the parameters, you can either click the Done button (which will mean the parameters have only been altered for the current FAOMET session), or you can click on Save preferences, which will mean that you will retain these values the next time the program is run.

6.2 The Help menu
On-screen help is available via the Help menu.  Clicking on this menu will bring up a menu of topics – click on one of these and the help window will appear.

The help window itself contains a Topics menu, which can be used to select further help topics.  Click on Exit from this menu (or the Done button) to close the help window.
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